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                   Preface 
_______________________________________________________________________ 
 

This IntelliVIEW for Notes Training Guide is designed for a one-day training 

program on how to use IntelliVIEW to analyze Notes data and create ad-hoc 

reports and charts. It has content for four sessions of one and a half hours each, 

takes the user through a systematic process to start using the product, and 

includes the advanced options as well. There is an additional session for the 

Domino version of the product, if required.  

 

In Session I  

Introduction to IntelliVIEW, you will be given basic information on the product 

and its features. 

 

Installing/Uninstalling IntelliVIEW, we will walk you through the installation 

and un-installation of the product. 

 

Working with IntelliVIEW, you will be trained on how to start working with our 

product. You will be able to transpose data into IntelliVIEW, learn basic 

operations in IntelliVIEW as well as create and save a format on completion of 

this chapter. 

 

In Session II 

Analysis in the IntelliVIEW Dynamic Grid, here we will discuss data analysis, 

grouping, sorting, filtering data, adding group summary, finding min, max and 

average, finding unique count, querying, sorting by summary values, show/hide 

group summary, advanced filters, multi value and adding a new computed 

column.  

 

In Session III 

Charting, Formatting, Printing: here you will be introduced to additional 

qualities of IntelliVIEW like creating & formatting charts, Active Charts, 

formatting rows, columns, header, footer, conditional formatting, exporting 

options, exporting and saving and emailing with attachments. 
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In Session IV 

IntelliVIEW for Domino, this chapter details the use of IntelliVIEW for Domino. 

The chapter covers the phases of “installation” and steps involved in “creating, 

saving, formatting, analyzing, exporting and printing in a Browser application”. 

This session is targeted for Administrators and Users who own IntelliVIEW for 
Domino only.   
 

In Session V 

Questions and Answers session, during the course of this session, feel free to ask 

questions and make use of the pages provided here to jot down those points. Ask 

specific questions about working with your own applications.



___________________________________________ 
CSS IntelliVIEW Training Guide 

Table of Contents 

What is IntelliVIEW? ...................................................................................................................2 
IntelliVIEW Versions ...................................................................................................................2 
About IntelliVIEW Features........................................................................................................3 

IntelliVIEW for Notes - Features ...............................................................................................3 
IntelliVIEW for Domino- Features.............................................................................................4 

How to Install IntelliVIEW..........................................................................................................5 
IntelliVIEW Installation for Notes.............................................................................................5 

Confirm Installation ................................................................................................................6 
Un-install IntelliVIEW................................................................................................................6 

Automatic Un-installation ......................................................................................................6 
Launching IntelliVIEW................................................................................................................7 
Starting IntelliVIEW....................................................................................................................7 
Working on IntelliVIEW ..............................................................................................................9 

The IntelliVIEW User Interface .................................................................................................9 
Menus .......................................................................................................................................9 
Toolbars ..................................................................................................................................10 
Views, Columns and Fields ...................................................................................................10 
IntelliVIEW Grid ...................................................................................................................10 

Working on IntelliVIEW Grid...................................................................................................12 
Views and Formats ................................................................................................................12 
Available Columns.................................................................................................................12 
Opening a Format..................................................................................................................12 

Operations from the Designer ..................................................................................................14 
Data Analysis in the IntelliVIEW Grid .....................................................................................16 

Grouping Columns.................................................................................................................16 
Ungrouping Columns.............................................................................................................18 
Ungrouping Columns.............................................................................................................19 
Sorting Columns ....................................................................................................................19 
Collapse and Expand Columns .............................................................................................20 
Filtering data .........................................................................................................................20 
Adding Group Summary........................................................................................................22 
Finding Min, Max and Average and Unique Count ............................................................23 
Sorting by summary values...................................................................................................23 
Show/Hide Group Summary .................................................................................................24 
Adding a new computed column ...........................................................................................25 
Multi Value fields ..................................................................................................................27 
Handling Multi Value Fields ................................................................................................27 

Creating a Chart.........................................................................................................................31 
Formatting a Chart................................................................................................................35 
Active Chart ..........................................................................................................................42 



___________________________________________ 
CSS IntelliVIEW Training Guide 

Formatting Columns, Rows and Cells......................................................................................45 
Formatting Columns..............................................................................................................45 
Formatting Rows....................................................................................................................48 
Formatting Cells ....................................................................................................................49 
Copy Cell ................................................................................................................................50 
Adjust width/height cell ........................................................................................................50 
Formatting Headers and Footers..........................................................................................51 
Conditional Formatting.........................................................................................................57 

Print Preview and Printing.......................................................................................................58 
Print Setup .............................................................................................................................60 
Printing...................................................................................................................................61 

Saving a Report .........................................................................................................................63 
Exporting a Report.................................................................................................................64 
Exporting Summary data......................................................................................................65 
Viewing data in Excel, PDF or Text .....................................................................................66 

E-Mailing a Report ....................................................................................................................67 
IntelliVIEW for Domino .............................................................................................................70 

Components and Installation ...................................................................................................70 
Components............................................................................................................................70 

Installing IntelliVIEW for Domino...........................................................................................71 
New Installation ....................................................................................................................71 

Configuring the Domino Server................................................................................................72 
Creating IntelliVIEW Report Formats in the Domino Server ...............................................73 

Creating a Format .................................................................................................................73 
Creating Action Buttons to invoke IntelliVIEW from the Browser....................................73 

Starting IntelliVIEW from the Browser ..................................................................................80 
Saving a format on the Browser ...............................................................................................81 
IntelliVIEW ActiveX Plug-in ....................................................................................................82 
Data Analysis using IntelliVIEW for Domino .........................................................................82 
Formatting Reports on the Browser.........................................................................................83 
Exporting Reports from the Browser .......................................................................................83 
Previewing and Printing over the Browser .............................................................................84 

Print Setup .............................................................................................................................84 
Previewing and Printing .......................................................................................................85 

What you can’t do through the Browser?.................................................................................86 
Notes ...........................................................................................................................................87 

 



Session – I Working with IntelliVIEW 

____________________________________________ 1 
CSS IntelliVIEW Training Guide 
 

 

      

 

 
 
 
 
 
 
 
 
 
 
 
In this session, you will learn the following: 

 

Lesson A  Introduction 

 

Lesson B  Installing/Uninstalling IntelliVIEW 

 

Lesson C  Working with IntelliVIEW 

 

 
 

 

 

 

 

 

 

 

 

 
 

Introduction, 
Installing/Un-installing, 

and Working with 
IntelliVIEW 
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_____________________________________________________________________________________ 

What is IntelliVIEW? 
IntelliVIEW is an add-on tool for Lotus Notes and Domino applications for dynamic 

querying, data mining and analytics. Data from Notes view is transposed into a spreadsheet 

like view. The spreadsheet is interactive allowing grouping, querying, sorting, filtering, 

counting etc. Dynamic addition and deletion of view columns, fields and computed columns 

with formulas are possible using IntelliVIEW.  

  

Using IntelliVIEW, data can be analyzed, reports can be printed, exported to Text, PDF and 

MS Excel, shown in the form of charts, mailed to other users and so on. It enables easy data 

analysis for the business user. 

 

IntelliVIEW Versions 
IntelliVIEW has two different versions, one for the Notes client, viz. IntelliVIEW for Notes 

and another for the Web, i.e., IntelliVIEW for Domino that works with web enabled 

applications. 

 

 

 

 
 
 
 
 

Introduction 
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About IntelliVIEW Features 

The features of both versions are listed below.  

IntelliVIEW for Notes - Features 

• IntelliVIEW for Notes presents a unique working environment that integrates the 

designing and viewing aspects together.   

• The new integrated User Interface enables viewing of columns appearing in the 

Viewer as the fields are selected, this makes design easy. Refer to topic, The 

IntelliVIEW User Interface.  

• Reports can be created with data from any Server/Database. IntelliVIEW allows the 

selection of fields in the current View as well as other Views in the database. Hence, 

consolidated reports from assorted views in a database can be created. 

•  Once data is in the Grid, it can be manipulated at the user's will to provide in-depth 

analysis of data in Notes applications.  

• IntelliVIEW provides grouping, querying, sorting, filtering, computing features to aid 

the user drill down and get reports. 

• Grouping of data under a column can be done by just dragging the particular column 

header and dropping it on top of the Grid.  

• Sorting of data is just by a click on the column header. 

• It is also possible to add a new computed column besides fields from the database.  

For details, refer to topics Grouping Columns, Sorting Columns and Adding a new 
computed column.  

• IntelliVIEW allows filtering of data based on single column values or even complex 

business logic spanning multiple columns.  

For details, refer to topic Filtering data. 
• IntelliVIEW allows quick and easy creation of elegant columnar reports range of 

formatting, grouping and sorting options. You can select the required columns, add 

new columns using any field in the database, delete existing columns, rearrange and 

resize columns. 
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• Column, bar, Line, pie, Point or Area charts can be created from reports by simply 

clicking on the IntelliVIEW chart icon. Charts can be created for All Values or 

Summary Values by specific selection of X-Axis and Y-Axis.  

 

• IntelliVIEW allows exporting data directly to PDF, Excel and Text formats, so the 

reports and charts can be shared with others.  

 

• The option to E-Mail directly from IntelliVIEW launches the default E-Mail client 

attaches the report and mails it out. 

 

For details, refer to topic Exporting and E-Mailing Reports. 
 

• The reports generated can be previewed before printing. You can also select different 

paper sizes. Several views of the report such as actual size, Full Page and Fit to 

width etc, gives a WYSIWYG picture of the report that is to be printed. 

 

For details, refer to topic “Previewing and Printing”. 

IntelliVIEW for Domino- Features 

• This version is used for web-enabled applications.  

• It is installed on a Domino server and hence anybody with access to that database 

can use it directly through action buttons in Domino application.  

• Data is analyzed, manipulated in Browser to create and generate Reports  

• It has all the features of IntelliVIEW for Notes, except the following: 

o Report formats are designed on the Notes Client and then saved on Domino 

Server. 

o On the Browser Columns can be deleted but cannot be added 

o Basic Filtering can be done in the Browser but Advanced filtering option is 

not available on the web 

o To e-mail reports created on Browser, first save it and then e-mail it. 

o To view IntelliVIEW Grid in Browser install the Active X plug-in on all 

Desktops. 
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_________________________________________________________________________________ 

How to Install IntelliVIEW 

Installing IntelliVIEW for Notes is very easy and takes only a few minutes. Installation can 

be anew or upgrading from an older version. After installing, it can be used immediately to 

create report formats and data analysis. 

IntelliVIEW Installation for Notes 

Perform the following steps if you are installing IntelliVIEW for the first time on your 

system or upgrading to a new version. 

  

1. Execute the IVSetup.exe file. IntelliVIEW for Lotus Notes Setup screen is displayed. 

If Lotus Notes is running you will be prompted to close it. Close the Lotus Notes 

client to continue with the installation. 

 

 

 

 

 

 

 

2. The Setup then displays the License Agreement for the purchase and usage of 

IntelliVIEW for lotus Notes. Read the agreement completely and accept the license 

agreement, if you wish to continue with the installation. Click on Next to continue. 

 
 
 
 

Installing/Un-installing 
IntelliVIEW 

Note: If you already have an older version of IntelliVIEW installed in the directory specified, the 
installer would give you two options - Modify and Remove. Select the option Modify to repair the 
previous installation or install the software in a new location. Select the option Remove to uninstall 

IntelliVIEW from your system. 

Note: Formats created using older version of IntelliVIEW can be opened and saved in new version 
of IntelliVIEW 
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3. Setup next prompts for the path for installation. By default, IntelliVIEW is installed 

in the notes directory. You can choose to accept the default path or choose a location 

of your choice to store the installation files and sample databases. Click Next to 

proceed with the installation.  

4. Now you can select the modules to be installed. Select the desired modules and click 

Next to install the software. 

5. Once the installation is over, the Installation Complete screen will be displayed. 

Select the option Yes, I want to launch readme file to view the contents of the readme 

file. Click on Finish to complete the installation. IntelliVIEW for Domino is installed 

in your system. 

 

Confirm Installation 
 
To confirm the installation, start the Lotus Notes Client and invoke the 'Actions' menu. You 

will find the following three new menu items: 

• IntelliVIEW – Open current View 

• IntelliVIEW – Formats 

• IntelliVIEW - selected entries. 

You can also see a Program group - IntelliVIEW for Lotus notes, created in the Program 

menu and a shortcut for the application in you machine desktop. 

 

Un-install IntelliVIEW 

Automatic Un-installation 
 

The following steps illustrate the process of automatic un-installation of IntelliVIEW: 

 
1. Close IntelliVIEW 

2. Click Start->Programs->IntelliVIEW for Lotus Notes ->Uninstall 

3. Uninstall screen will appear, confirm the path and click uninstall button. 

 
 

 

 

 
 
 
 

Working with 
IntelliVIEW 
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__________________________________________________________________________________ 

 

Launching IntelliVIEW 

 

IntelliVIEW can be launched from the Actions menu in one of two ways: 

 

• “IntelliVIEW – Open selected Entries” option allows creating a report format from 

the selected documents. 

 

• “IntelliVIEW - Open Current View” option loads the records from the current Notes 

View onto the IntelliVIEW Grid. 

 

• “IntelliVIEW - Formats” option allows creating a report format before processing the 

data. As well, saved formats can be opened, exported or printed directly from the 

Designer. 

 

Starting IntelliVIEW 

Starting IntelliVIEW can be done by two ways. 

1) To open the selected documents in the IntelliVIEW Grid, select the 

documents from the Notes database and click Actions from the menu and 

then click on IntelliVIEW – Open selected entries as shown below. 
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(Figure 1.4) 
 

2) To open the current view in IntelliVIEW Grid click Actions from the menu 

and then click on IntelliVIEW – Open current View as shown below  
 

 

 

 

 

 

 

 

 

 

 

 

 

 
(Figure 1.5) 
 

3) To open a previously saved IntelliVIEW format or a View from any 

databases/servers, click Actions from the menu and then click on IntelliVIEW 

–Formats as shown below 
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(Figure 1.6) 
 

Working on IntelliVIEW 

The IntelliVIEW User Interface 

The IntelliVIEW UI is composed of the following components. 

 

 Menus 

 Toolbars 

 Format explorer and Available columns 

 IntelliVIEW Grid 

 
Menus 
  

The IntelliVIEW application has the following menus.  

 File Menu 

 Grid Menu 

 Chart Menu 

 View Menu 

 Help menu 
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Toolbars 
  

The IntelliVIEW window has a set of toolbars namely Standard, Grid, Column Formatting, 

Chart and Search.  

These toolbars can be shown / hidden by selecting or deselecting the Standard Toolbar, Grid 

Toolbar and Search bar from the View -> Toolbars menu. Toolbars can be placed anywhere 

and resized.  

 

 
  
 

 

 

 

 

 

 

 

 

 

 

 

 

 
Views, Columns and Fields 
  

The IntelliVIEW window displays Views, Formats and Fields on its right frame namely. The 

Views and Formats section displays all the views and formats in the database for selection. 

Similarly, Available Columns sections display all the columns and fields in the form and it 

allows selection or removal based on user requirement.  

This pane can be shown / hidden using the toggle feature View -> Format Explorer Task 

Pane.  

 

 

 

IntelliVIEW Grid 
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The IntelliVIEW Grid is a dynamic spreadsheet facilitating ad-hoc analysis and report 

generation.  

 

It has three Tabs - IVIEW, Filters and Chart. Each tab has the following options: 

• “Grid” allows previewing Notes data in the Grid and performing analysis, formatting, 

adding fields, deleting fields and other options.  

• “Filters” defines rules for selecting or removing data from the Grid 

• “Chart” is displayed after creating charts 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

• Refresh Icon - When you add a new column to the IntelliVIEW Grid, click this 

Icon to fetch data and refresh the view. 

 

• Fit to Page – If the columns are not properly positioned then click on the icon to fit 

the report to size of page.  
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Working on IntelliVIEW Grid 

Spreadsheets created using IntelliVIEW can be formatted as per user preference. To start 

with, let us consider the sample database in the Notes data directory. Click on the sales view 

to view the sales details.  

 

 

 

 
 
Views and Formats 
 

Views and Formats will display the available views and format in a database.  

 

To change the views click on the Note Views under View and Formats area select a view and 

then double click to view corresponding view on the grid.  

 

To view formats, click on 'IntelliVIEW Formats' under 'Views and Formats' area select a 

format from the list and then double click to view corresponding format on the grid.  

 
Available Columns  
 

Available columns will display all the columns that are in the view and fields from that form. 

This is divided into Formula, View Columns and Fields. 

 

Formula: The user can add a new column by applying a Notes formula. Double click on the  

 

View Columns: Columns can be deleted in a spreadsheet by Clicking Check boxes on 

“Columns” field. While adding a column each time, refresh it. Click Refresh Grid icon to 

populate the rows with data from the selected Notes View. 

 

               

 

Opening a Format 
 

Note: Through out this training guide Sample Database with sales view is considered 

as the example for all options.  
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A format is a database file that is used for creating reports. Format can be opened from a 

Designer or from the IntelliVIEW Client. To open a saved format from IntelliVIEW client 

please follow below steps: 

IntelliVIEW 
1. Select Format -> Open Format. The Open Format dialog is displayed. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
  

 
 
            (Figure 1.12) 

 
2. All formats available in the current database are displayed. 

3. Choose a required format and click Open to open the format in the IntelliVIEW Grid 

with empty rows. 

4. Click Refresh icon to populate the rows with data. 

 
IntelliVIEW - Designer 
 

1. In the Lotus Notes client Select Actions -> IntelliVIEW – Formats from the menu 

2. Choose a format that are available in the current database 

3. Click “IView” to open the format in the IntelliVIEW Grid.  

4. Click Refresh Grid icon to populate the rows with data. 

 

IntelliVIEW – Open selected entries 



  Session – I Working with IntelliVIEW 

___________________________________________14  
CSS IntelliVIEW Training Guide 

1. Select the documents from the current database. 

2. In the Lotus Notes client Select Actions -> IntelliVIEW – Open selected entries from 

the menu to open the selected documents in IntelliVIEW. 

Operations from the Designer 

From the Designer, a user can choose to do a variety of quick operations:  

• Select a database and open a View in the Grid 

• Select and open a saved IntelliVIEW format 

• Without opening the Notes View in the IntelliVIEW Grid: 

o Select and export a View to Excel, PDF, or Text 

o Select and print a View  

o Select a View and attach it as an Excel or PDF to email. 
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_____________________________________________________________________________ 

 

IntelliVIEW allows dynamic analysis, querying, drill down and creation of ad-hoc reports.  

On completing this session, you will be able to do: 

 

 Data analysis in the IntelliVIEW Grid 
 

 Grouping 
 

 Sorting 
 

 Filtering Data 
 

 Adding Group Summary 
 

 Finding Min, Max and Average 
 

 Finding Unique Count 
 

 Querying  
 

 Sorting by Summary Values 
 

 Show/Hide Group Summary 
 

 Advance Filters 
 

 Adding a new computed column 
 
 

 
 
 

Analysis in the 
IntelliVIEW Dynamic 

Grid 
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Data Analysis in the IntelliVIEW Grid 

 
1. Once data is in IntelliVIEW Grid, data can be manipulated at user's will to provide 

in-depth analysis and reports in Notes applications.  

 

2. IntelliVIEW provides grouping, querying, sorting, filtering, computing features to aid 

the user drill down and get reports. 

 

3. IntelliVIEW allows filtering of database on single column values or even complex 

business logic spanning multiple columns.  

 

Grouping Columns 
 
Grouping data under certain key values can create both simple and complex reports. 

IntelliVIEW makes grouping data an effortless activity, through its drag and drop feature. 

For example, if a Sales spreadsheet has Customer, Product, Quantity, Unit Price, Sales 

Revenue and Account Manager as fields. 

 

Drag a column header under which data has to be grouped, and drop it over the group frame.  

This is the easiest way of grouping data. 

 
As shown in the below figure, data has been grouped with “Account Manager”. 
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Dragging and dropping column headers subsequently can do multi-level grouping. Here, for 

example, drag and drop the column header “Product” under “Account Manager”. 
 

 
 

 
The other way to Group is by right clicking on a Column and selecting “Column Settings” or 

“Group by” from the options as shown below. 
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Select the required column from the left pane. In the Column tab, enable the check box 

“Grouped” to group data under the selected column. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The data is grouped under the selected column header. The same way selecting columns 

subsequently can do multi-level grouping.  
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Ungrouping Columns 
 

Simply dragging the group header from the group frame back to the Grid can do ungrouping 

or by right clicking the group header and selecting Ungroup from the options. 

 

 

 

 

 

 

 

 

 

 

 

In case of multilevel grouping, only the grouping corresponding to the particular group 

header is undone. 

 
Sorting Columns 
 

There are a number of convenient methods to sort a column in IntelliVIEW. Click on a 

particular column header to sort the column ascending or descending. The triangle pointer 

that appears indicates the order in which the column is sorted. 

Right click on a column and select “Column Settings” to display the column settings dialog.  

 

 

 

   

 

  

  

  

 

 

 

 

Note: The other way is to select “Sort Ascending” or “Sort Descending” to sort the data.
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In the Column tab, click Sort Ascending or Sort Descending to sort the data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Collapse and Expand Columns 
Collapse all groups by clicking the Collapse icons . “Expand” columns by clicking on  

icon.  

 

 

 

 
 
Filtering data 
  

IntelliVIEW provides two different features for filtering data.  

 

Basic Filtering 
  

IntelliVIEW offers filtering options similar to Excel. Click the  button on a column header. 

A drop-down box lists all values appearing in the column. 

Note: You can also Expand Up to an intermediate level of grouping by clicking this  icon.
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Select a Value to display only records containing that value. 

Select All to display all records. 

Select Custom to display records that fall under a specified condition.  

 

For example, Consider a condition that will show rows which have a value greater than 

10000 and lesser than 50000 as shown below.  
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Advanced Filters 
  

The Filters tab available in IntelliVIEW for Notes and it is not provided in IntelliVIEW for 
Domino. Hence, it is not possible to apply business rules to multiple columns on Domino.  

 

To apply advanced filters double click on any of the columns in ‘Available Columns’ and 

apply the condition. The user can group the conditions based on his requirement. The group 

can be either a logical group or non-logical group. 

 

 

 

 

 

 
 
 

 
 

 
Adding Group Summary 
   

After grouping the data, it is now time to summarize the revenue for each of the customer.  

The following steps are executed to accomplish the task. 

1.       The empty row that divides the groups is said to be the group footer. Right click on it. 

2.       Select the option Sum. 
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Finding Min, Max and Average and Unique Count 
 
Following are the available summary values that can be applied for a group/column. 

  

  

Summary Value 

  

  

Description 

  

Sum 

  

Sum of the numeric values of a column in a group 

Min 

  

The least numeric value of a column in that group 

Max 

  

The largest value of a column in a group 

Count 

  

Number of documents in a group  

Average 

  

Average of the values of a column in a group 

Unique Count 

  

Number of unique values in a group   

i.e. records with duplicated values are not included 

in the count.  

 

 
Sorting by summary values 
 

When data is grouped, sorting based on summary values is now possible besides sorting on 

individual values.  

 

Right click on the summary value based on which the groups are to be sorted. 

Select Sort Ascending or Sort Descending. 
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Show/Hide Group Summary 
 

You can choose to show or hide the summary footer at any point of time. There are a number 

of ways to do this. 

The same way right click the group header and select Hide Summary to hide the summary. 

 

 

 

  

 

Note: In case of multilevel grouping, only the summary footer pertaining to that 

particular header will be hidden. 
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In the same way right click on the group summary footer and select Hide Summary to hide 

summary. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 
 

 

From the menu, select Grid -> Show/Hide -> Group Summary (This is a toggle feature.) to 

hide the summary or right click the group header. Select Show Summary. 

 

  

 

 

 

 

 

 

 
 
 
 
 
 
Adding a new computed column 
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It is possible to add a new computed column to the report apart from the Notes View columns 

and fields existing in the database. This is typically used for calculating something that is 

not available in the database. Select Grid -> Add New Computed Column. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On clicking Add New Computed Column from the Grid Menu, the Format Column dialog is 

displayed.  
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A new computed column can be added from here. Enter the column heading or caption for 

the new column. Next, enter the formula for the calculation, for example to calculate 

Revenue, the formula is Quantity x Cost.  

 

A new column is created called Revenue refresh the Grid, and the revenue is calculated 

based on the formula and displayed. 

 

Multi Value fields 
 

IntelliVIEW fully supports Multi value fields. By default, IntelliVIEW will treat all the 

entries in Multi value fields as a single entry with a separator. However, the user can treat 

each value in Multi value fields as separate entries by changing the properties. 

 

The following are the ways in which multi-value fields are handled: 

 

• When IntelliVIEW encounters a multi-value field, by default it converts multi-value 

text fields into a single text or string, using the same Multi-value separator to 

separate the multiple values in the field. You can use other Multi-value separators to 

separate the multiple values by changing the properties of the field.  

 

• You can view each value in Multi-value fields as separate entries by mapping with 

other fields.  

 

• You can change the value to only one value by changing the properties. 

 

• While handling 'multiple' multi-value fields, the user can map these fields in one to 

one and one to many co-relation methods. 

 

Handling Multi Value Fields 
 

IntelliVIEW can handle multi-value fields largely. When IntelliVIEW encounters a multi-

value field, by default it converts multi-value text fields into a single text or string, using the 

same Multi-value separator to separate the multiple values in the field.  

  

The following are the ways in which multi-value fields are handled: 

 



  Session – II Analysis in IntelliVIEW Grid 

___________________________________________28  
CSS IntelliVIEW Training Guide 

Multi-value fields with different separator 

Using IntelliVIEW, user can change the separator of Multi-value field to Coma, Space, 

Semicolon, New Line and none. Follow the steps below: 

 

• Right click on the Column header and select Column Settings. 

• In Column Settings, select Data Format tab, and under Multi-value settings check 

'Show multi-value as single entry' check box and then select a separator from 'Multi-

value separator' list box 

 

Multi-value fields as single entry 

  

Using IntelliVIEW, user can change the properties of Multi-value fields to only one entry. 

Follow the steps below: 

  

• Right click on the Column header and select Column Settings. 

• In Column Settings, select Data Format tab, and under Multi-value settings check 

'Show only first value' check box. 

Multi-value fields treat each value as separate entry (One to All relation) 

 

 Using IntelliVIEW, user can change the properties of Multi-value fields where each value 

can be viewed as a separate entry by mapping with other fields. Follow the steps below: 

 

• Right click on the Column header and select Column Settings. 

 

• In Column Settings, select Data Format tab, and under Multi-value settings check 

'Show multi value as separate entries' check box and then check 'Map one value to all 

values of other multi-value columns' 

 

 

 

 

 

Multi-value fields treat each value as separate entry (One to one relation) 
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Using IntelliVIEW, user can change the properties of Multi-value fields where each value 

can be mapped to the other multi value field which is separated. In this case each value is 

mapped to all values of other multi-value fields. Follow the steps below: 

 

• Right click on the Column header and select Column Settings. 

• In Column Settings, select Data Format tab, and under Multi-value settings check 

'Show multi value as separate entries' check box and then check 'Map each value to 

the previous separated multi-value column'.  
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______________________________________________________________________________ 

This session is mainly to do with formatting reports and sharing with others. On completing 

this chapter, you will be able to create charts, format reports and charts, preview and print, 

export to other formats and email reports. 

 

Lesson A Charts 

 

Lesson B Formatting 

 

Lesson C Preview and Printing 

 

Lesson D Exporting 

 

Lesson E Emailing with Attachments 

 

 

 
 
 

Charts, Formatting, 
Printing, Exporting 
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Creating a Chart 

  

After data is arranged in IntelliVIEW Grid, it is easy to create a chart by using Chart 

wizard. Different types of charts like Column, Bar, Line, Pie, Point and Area charts can be 

created. 

To start with the chart wizard, click chart  icon. The following dialog box is displayed. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

Charts 
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For example, to create a Chart for all Account Managers and their sales revenue region wise. 

Follow the steps given below 

 

• First Group the spreadsheet with Account Manger and sum of their sales revenue as 

shown below. 

 

 

• Click chart wizard  icon from Toolbar Menu. 

• On Series box, the user can either select “Default” series or by clicking on “Multi-

Series”. 

• Click on Multi-Series, select “Region” and select Asia and Africa from the list. 

 

 

 

 

Note: We can select all Regions by clicking  and to uncheck all fields click . 
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• On Chart Type box, select a Chart type.  

• Check the checkbox Color Each to color each value. 

• Select a Bar style from the Bar Style list, select a pattern from Fill Pattern list, select 

a Bar Type from Bar Type list and in the Bar Width box type or select the width. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click "Next" to select value for X-axis.  In the Column box, select a field that should 

appear on the X-Axis of the chart. (Only the non-numeric fields are available here for 

selection). In the Values box, select specific values to appear in the X-Axis based on 

the field selected in the Column list. (All the values of the selected field gets listed 

here, with provision to check or un-check the values.)  

• Click "Next" to select value for Y-axis. In the Column box, select a field that should 

appear on the Y-Axis. (Only the numeric fields on the grid are listed here). In the 

Value by, select a group summary function from Sum, Average, Count, Maximum 

and Minimum. 
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o For example, select AccountManager as the X- Axis, SalesRevenue as the Y - 

Axis, and select Sum to display the sum of sales revenue of each account 

manager against their respective names.  

 

 

 

 

 

• Click Finish to display the chart, as designed, in a new tab, chart as shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Select the values to be displayed in chart by clicking on check box. . To check all fields click on 

 icon, to uncheck all fields click on . 
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Formatting a Chart 
 
Once created, the properties of the chart can be altered as needed.  

 

Format Chart Title 

 

To add Chart Title, X-axis Title and Y-axis Title follow the below steps: 

 

• Click the Format Chart icon  and select Chart Title or “Right click” on the 

chart and select Format Chart and Chart Title to change chart title and font.     

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• On Title tab, check Visible to view the Chart Title in Chart. Enter the chart name in 

the Title Text box. 

• On Font tab, format the chart title font by selecting a suitable Font name and size. 

Align the Chart Title by selecting an alignment from the Alignment radio button. 
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Format X-axis  

• Click the Format Chart icon  and select X-Axis or right click on the chart and 

select Format Chart and X-Axis to format X-axis.     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• On Title tab, check Visible to view the Chart Title in Chart. Enter the chart name in 

the Title Text box. 

• On Labels tab, format the label style by selecting a suitable Font name and size. 

Align the label text by selecting an alignment from the Alignment radio button. 

Change the orientation of the labels. 

• On Lines tab, check Visible to view the lines. Format the line style by selecting a 

suitable style, weight and color. The user can scale the values of x-axis by selecting 

values. 
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Format Y-axis  

Click the Format Chart icon  and select Y-Axis or right click on the chart and select 

Format Chart and Y-Axis to format Y-axis.     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• On Title tab, check Visible to view the Chart Title in Chart. Enter the chart name in 

the Title Text box. 

• On Labels tab, format the label style by selecting a suitable Font name and size. 

Align the label text by selecting an alignment from the Alignment radio button. 

Change the orientation of the labels. 

• On Lines tab, check Visible to view the lines. Format the line style by selecting a 

suitable style, weight and color. The user can scale the values of y-axis by selecting 

values. 
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Format Chart Type and Data 

Click the Format Chart icon  and select Chart Type & Data or right click on the chart 

and select Format Chart and Chart Type & Data to change chart Type, chart series, X-axis 

data and Y-axis data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On Chart Series- Type tab, 

• Series - Select "Default" series to create Charts. To create charts with a Series, click 

on "Multi-Series" and select fields.  

• Chart Type - Select a Chart from the chart type box, the chart can be formatted by 

selecting the following options: 

 

o Color Each - Check the box to color each area of the Chart 
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o Bar Style  - Format the bar style for Bar and Horizontal Bar charts by 

selecting a bar style from Bar Style drop-down list, adjust the Bar Width, 

choose a Fill Pattern from Fill Pattern drop-down list to change the look and 

feel of bars.  

o Format Area charts by selecting a point style from Point Style drop-down list 

and check the Stairs option to show area in stairs.  

o Format Point charts by selecting a point style from Point Style drop-down list 

and adjust the height and width of the point. 

o Format Line charts by selecting a point style from Point Style drop-down list 

and check the Stairs option to show the line as stairs.  

o Format Pie charts by selecting Angle, Radius. Check Semi Pie to display the 

pie chart in Semi pie. Check Explode Biggest to show the highest value 

separately from the Pie chart. 

• On Categorized (X) Axis tab, format the X-Axis by selecting different fields and a 

user can select all the values of a field by selecting All in Value radio button, to select 

specific values select Selected in Value radio button. 

• On Y Axis tab, format the Y-Axis by selecting different fields and Value by options 

 

Format Chart background 

Click the Format Chart icon  and select Chart Area or right click on the chart and 

select Format Chart and Chart Area to format chart background.    
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• Insert a background Image for the chart.  

• Apply a background color to the chart. 

• On Gradient area, to view grids in the chart check Visible, to view border check 

Border visible. 

 

Format Legend  

Click the Format Chart icon  and select Legend or right click on the chart and select 

Format Chart and Legend to format legend. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• On Legend tab, check Visible to view the Legend in Chart. Format the frame of the 

Legend and position the Legend. 

• On Font tab, format the label style by selecting a suitable Font name and size. 

Change the orientation of the labels 
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Format Series 

Click the Format Chart icon and select Series or right click on the chart and select 

Format Chart and Series.  

 

 

 

 

 

 

 

 

 

 

 

• Check Visible to view labels in Chart. Select the value style from Style drop-down 

box. 

• Change the series color by selecting each series value. 

 

Format Labels 

Click the  button or right click on chart and select Labels to select one of the different 

types of marks over the chart. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Options  
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• Visible – Toggle the visibility of Legend details. 

• Mark Type – Select a type from the available list to appear as labels 

over the chart 

o Value – The Y-axis value at the point is displayed  

o Percent – Percentage value of Y-axis value is displayed 

o Label – The X-Axis value at the point is displayed 

o Label and Percent – combination of X-axis field values and 

percentage of Y-axis field values as labels  

o Label and Value – combination of X-axis field values and 

value of Y-axis field appear as chart labels 

o Percentage Total – combination of percentage of Y-axis field 

values and total of all the field values in Y-axis as chart labels 

• Click the  button or right click on chart and select Show/Hide Legend to toggle the 

visibility of Legend detail. 

• Click the  button or right click on chart and select Toggle 3D to toggle the 

appearance of 3D effect in the chart. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Active Chart 
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IntelliVIEW for Notes has a powerful Interactive chart interface where in the user can create 

WYSIWYG Charts. You can fully customize the appearance of the charts to present any data 

with maximum visual impact. 

 

A user can create Chart in two ways. One is through Chart wizard and second is through 

Active chart. In this section, we will see how to create charts using Active chart option. 

 

There are two ways one can use Active chart option. 

 

1) Create charts using Active chart option 

2) Changing the properties of the chart using Active chart option 

 

Create charts using Active chart 

 

Creating chart using Active chart is simple and straightforward. Click on the Active chart 

Icon or click on the menu Chart --> Chart, this will populate chart tab and Active chart 

pane. In Active chart pane you will have two tabs Series and Categories.  Using Active chart 

the user can create both simple and series charts. 

 

To create a simple chart follow the steps below: 

 

1. Click on the Active chart Icon   

2. In the Active chart pane go to Series tab, fields will be grouped based on the field 

that has numbers. 

3. Expand the numeric field with which you want to create a chart and select the 

values.  

4. The output can be seen on the chart tab of your workspace as you select values. 

 

 

 

 

 

 

To create a series chart follow the steps below: 
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1. Click on the Active chart Icon    

2. In the Active chart pane go to Categories tab, select a filed name from Column box 

and select the fields from Values box to create series chart 

3. Click on Series tab to check the fields needed to be added in the chart. 

4. The output can be seen on the chart tab of your workspace as you select values. 

 

Changing the properties of the chart using Active chart option 

 

Change the properties of the chart using Active chart is easier. The user will not have any 

difficultly to create the chart again and can change the fields by selecting fields from Active 

chart pane. 
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_____________________________________________________________________________________ 

 

Formatting Columns, Rows and Cells 

 IntelliVIEW extends its formatting options to each row, column and cell.  

 

Formatting Columns 
  

Formatting columns has a lot more than just applying style. The data format, decimal places  

(Numeric columns), and summary type can be defined here. 

 

Click the Columns Settings icon  or right click the column header band, Grid cells or 

group header, and selecting Format Column The format column dialog. The format column 

dialog can also be invoked by clicking the Column Settings icon  

 

The format column dialog contains five tabs as shown in the figure.  

  

Select the column to be formatted from the list available in the left pane of the Column 

Settings dialog. 

  

 
 
 
 
 

Formatting 
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(Figure 3.13) 
 

The five tabs and their usage are explained below: 

 Column 

 Data Format 

 Summary Values 

 Style 

 Conditional Style 

 

Column   
 

• Caption – Enter the column title.  

• Formula – Displays the formula that defines the column. This is Not editable.  

• Grouped – Click on the check box to group a particular column.  

• Sort – Select the sorting option. 
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Data Format   
 

• Data Type – Select the column data type (String, Number, Date-Time or Image)  

• Number format – Enabled, if data type is Number  

• Decimal places – Enter or Select the decimal places required in the number field. 

• Currency – Check this option, if the numeric column value is currency. 

• Punctuated at thousands  – Check this option, if the punctuation is needed at 

thousands for the numeric column values.  

• Date-Time format – Enabled if data type is Date-Time  

• Date – Select the format for the date value (Select No Date, if time alone need to be 

displayed). 

• Date separator – Select the date separator. 

• 2 digit year – Check this option, if the year values in the date need to be two digits. 

• Time – Select the format for the time value (Select No Time, if date alone need to be 

displayed). 

• Time separator - Select the separator for time. 

• 24 hour format – Check this option, if the time needs to be in 24-hour format.     

 

Summary Values 
  

The summary values appearing in the group summary footer or report footer for a particular 

column can be specified in this section. 

• Group Footer Summary - If the selected column has data grouped under it, then you 

can specify the group summary values in this section.  

• Summary type - Select a summary type from the list.  

• Label - Assign a suitable label for the footer. 

 

 

 

 
• Report Footer Summary - Report Footer summary values can be specified for any 

column. It summarizes all the values appearing in that column. 

• Summary type - Select a summary type from the list.  

 

Note: We can specify Summary values by right clicking on the group summary footer. 

See Formatting Summary. 

Note: Arithmetic operations such as Sum, Min, Max and Average will be listed only 

for numeric columns. 
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Style   

• Font - Select the font name, size, color and style such as Bold, Italic, Underline and 

Strikethrough for the column values. 

• Alignment - Select the alignment of the column values. 

• Background Color - Select the background color for the column values.   

Conditional Style  
• Condition List  - Name for the condition can be given using the Add button. Clicking 

the Add button will give the pop up in which the condition name can be given. 

Clicking the Delete button, will delete the selected condition.                      

• Condition - Select the condition to be applied to the selected column value. Enter the 

value to be compared with the selected column value 

• Style - Select the style to be applied for the column values that matches the entered 

condition.  

• Font - Select the font name, size, color and style such as Bold, Italic, Underline and 

Strikethrough for the column values. 

• Alignment - Select the alignment of the column values. 

• Background Color - Select the background color for the column values.            

 

Formatting Rows 
 Right click on any Grid cell and select Format Row. 
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The Format Row dialog is displayed as shown below.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Font - Select the font name, size, color and style such as Bold, Italic, Underline and 

Strikethrough for the selected row. 

• Alignment - Select the alignment of the row content. 

• Background Color - Select the background color for the row.  

 

Formatting Cells  
 
Right click on any Grid cell and select Format Cell. The Format Cell dialog is displayed as 

shown below.  
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• Font - Select the font name, size, color and style such as Bold, Italic, Underline and 

Strikethrough for the cell content. 

• Alignment - Select the alignment of the cell content. 

• Background Color - Select the background color for the Grid cell.  

  

Copy Cell 
 
Right click on a cell and select Copy Cell to copy the cell value on to Windows clipboard. You 

can paste this value in any document that supports Windows clipboard items.  

 
Adjust width/height cell 
 
Adjust the width and height of a cell by performing the following options: 

• Right click on a cell and select “Fit width to content” to adjust the cell as per width of 

text content. 
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• Right click on a cell and select “Fit height to content” to adjust the cell as per height 

of the text content. 

 
Formatting Headers and Footers 
  

The headers and footers that you can add to your report are listed below: 

 

• Report Header 

• Page Header and Footer 

• Group Header 

• Column Header 

• Group Summary Footer 

• Report Footer 
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Report Header 
 
Report Header displays the report title and it is displayed only on the first page, while 

previewing or printing. Report Header appears as the first band in the Grid. By default, the 

name of the selected view is displayed as report title, which can be changed as required.  

 

The following operations can be performed on the Report header. 

• Resizing - The band thickness of the report header can be increased or decreased by 

dragging its bottom margin. 

• Rename Title - Right click the Report Header (View Header) select “Rename Title” to 

display the respective dialog. Enter a suitable title for your report and click “OK”.  

• Format Title - Right click the Report Header (View Header) select Format Title to 

display the respective dialog. Modify the font style, color and background color of the 

column header.  

 

Page Header & Footer 
  

Page Header and Footer appear on each page of the IntelliVIEW report, while previewing or 

printing. The page header and footer can be shown or hidden using the toggle option  

View-> Page Header Footer. 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 



Session III- Formatting 

___________________________________________53  
CSS IntelliVIEW Training Guide 

Right click the page header or footer to display the following options. 

  

• Format Control 

• Delete Control 

• Add Text 

• Add Page Number 

• Add Date 

• Add Time 

 

Select Page Number, Date, Time and Text as Page Header as shown below. Text can be 

formatted in Style Tab. 
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Column header 
 

The column header displays the caption of all columns. The following operations can be 

performed on the column header. 

  

• Resizing - The band thickness of the column header can be increased or decreased by 

dragging its bottom margin. 

 

• Applying Style - Right click on any Column header and choose Format Column 

Header where style of font can be changed. Modify the font style, color and 

background color of the column header. 
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Group Header  
  

The Group Header displays the values of the column under which data is grouped. The group 

header band cannot be resized. Right click the Group Header and select Format Group to 

Format font style, color and background color for that group header. Modify the font style, 

color and background color of the group header. 

 

 

 

 

 

 

 

 

 

 

 

 

Group Summary Footer  
  

Group summary footer is the band displayed at the bottom of each group. It is used to display 

the summary value pertaining to that group. 

 

The following operations can be performed on the group summary footer. 

• Format Summary - Right click on group summary footer and select Format 

Summary. Select a summary type from drop-down list. Change the default label if 

required, by typing a suitable text. Click the tab Style to change the font style, 

alignment of the summary values and background color. 

• Hide Summary - Right click on group summary footer and select Hide Summary to 

hide the summary footer from report.  
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Report Footer 
  

Report footer displays the summary values pertaining to the whole report and it is displayed 

only on last page of report. 

 

The following operations can be performed on the report footer. 

  

• Format Summary - Right click the Report footer (View Footer) select Format 

Summary. Select a summary type from the drop-down list. Change the default label 

if required, by typing a suitable text. Click on Style Tab to change the font style, 

alignment of summary values and background color. 

 

• Footer Background color - The background color of the Report footer can be changed 

without selecting the Format summary option. Right click the Report footer and 

select Footer Background color. Color palette is displayed select a suitable color for 

the footer background. 
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Conditional Formatting 
 

Conditional formatting is used to show up a field in a different color if it meets criteria 

specified by the user. The Conditional Style tab in the Column Setting dialog is used to apply 

a particular style. 

 

For example, the background color of the column Account Manager can be changed only in 

those cells of the column where its value is Christopher. 

 

To highlight Sales revenue greater than $50,000 use Conditional style formatting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Session III – Preview and Print 

___________________________________________58  
CSS IntelliVIEW Training Guide 

  

  

 

 

 

 

 

 

 

 

_____________________________________________________________________________________ 

 

Print Preview and Printing 

IntelliVIEW has powerful features for previewing and printing reports directly from the 

Notes application. Once the formatting is complete, a WYSIWIG preview of the report can be 

seen before printing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select File -> Preview. 

 

The preview of the report is launched in a separate window as shown in the following figure. 

 
 
 
 
 

Preview and Print 
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The buttons in the preview window enable different types of views of the report.  

You can directly print the report from the preview window by clicking the Print icon . 

  

 
 



Session III – Preview and Print 

___________________________________________60  
CSS IntelliVIEW Training Guide 

 
Print Setup 
  

There is a facility to force new pages for each group (if the report contains groups) and select 

from a range of paper sizes, before previewing.  

 

 Select File -> Preview Setup or click the  icon to display the following dialog. 

 

 
 

• Paper size tab - Select a Paper size by clicking on drop-down list. Select any page 

Orientation that is suitable for report.  

• Margins tab - Change the margins of the report by adjusting the inches. 

• Grid tab - Each group can be forced to be printed in a separate page and to print a 

page without colors by clicking on No colors check box. 
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 By checking on Account Manager check box, Pages are spited as per groups 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Printing 
  

Reports generated using IntelliVIEW can be printed from different printers and on various 

paper sizes. 

  

Select File  -> Print or click on the  icon. The Print dialog is displayed in which you select 

the printer, specific pages for selection, and number of copies of the report.  

After setting all the required properties, click OK to trigger printing action. 
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_____________________________________________________________________________________ 

Saving a Report 

After formatting the data on Grid, the format can be saved as a notes document. Select     

File  Save Format from menu or click on  icon to save a report.  

Type a Format Name and Title in the dialog box and click on “Save” button to save a report 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
 
 
Saving, Exporting and 

Viewing 
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Exporting a Report 
 
Reports generated in IntelliVIEW can be exported and saved in any file format. IntelliVIEW 

provides exporting options, which enables to export summary values and reports with 

filtered data. Reports created can be exported Text, Excel and PDF. 

  

Select Format -> Export to...  and then choose the required file type form the submenu that is 

displayed. Alternatively, click on the Export icon . Specify the destination folder and 

click Save to save the report.   
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Alternative Method 

  

Select “IntelliVIEW – Formats” from “Actions” menu. The startup dialog is displayed.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(Figure 3.31) 

 

Select the View/Format that has to be exported. Click the Export button and choose the 

required file format from the submenu to export the selected report. 

 

 

  

 
 
Exporting Summary data 
 

Exporting Summary and Filtered data as present on the Grid can be done easily. 

 

 

 

 

  

Note: Using the above options, charts can be exported to PDF only or copied to a 

PowerPoint or Word file. 
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If the report contains groups, then it is possible to export only the group headers with 

summary values to a different file format. Similarly, data filtered using Filters are also not 

displayed in the exported reports. In short, IntelliVIEW offers you WYSIWIG export to 

different file formats. 

 

Perform the following steps to export summary data. 

  

• Collapse all groups by click on the “Collapse all” icon .  

• Select Format -> Export to... and choose the required file format. 

   

The report is exported to the specified file format with only the group header values and 

summary values. 

  

  

 

 

  

Viewing data in Excel, PDF or Text 
 

If you just want to view data in the IView Grid in Excel, PDF or Text, click on the View As 

icon .  This will open the data in the selected file format immediately. 

Note: You can also expand up to an intermediate level of grouping by clicking the  icon. 
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________________________________________________________________________________ 

 

E-Mailing a Report 

The report generated can be mailed in the form of Excel or PDF file attachments. 

 The following steps illustrate the exporting of a report. 

 1.       Go to Format menu, then select E-Mail, and then choose Excel. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

       

2.  A Mail dialog is displayed, From address will be automatically populated with the current 

working id of the Notes application. The user can even rename the attachment. 

 
Emailing with 

attachment 
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Enter the To address, Subject and Body of the mail and click on Send. 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

     

A mail is sent to the specified address with the report as an excel file attachment and a 

confirmation message is displayed to the user. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: You can do the same action by clicking on the Email icon on the toolbar  icon. 
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_____________________________________________________________________________ 

 

IntelliVIEW for Domino has most of the features of IntelliVIEW for Notes, but not all. In 

addition, it works with the web-enabled applications through the Browser. This session deals 

with topics specific to using IntelliVIEW for Domino: 

 

 

Lesson A For Administrators 

 

Lesson B For Users 

 

Lesson C Limitations 

 

 

 
 
 

IntelliVIEW for Domino
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IntelliVIEW for Domino 

Components and Installation 

Components 
 

• Install IntelliVIEW for Domino on the Server where the Notes web enabled 

applications are installed 

• To view the IntelliVIEW Grid in the Browser, the Active X plug-in needs to be 

installed on all desktops. This can be done in two ways. 

o The first one is an automated process; while clicking on the IntelliVIEW 

button for the first time the Active X plug-in will be installed automatically. 

o The other way is to open the IVAxSetup.exe file to install the Active X plug-in 

in your system. The same can be downloaded from the following URL  

http://www.synaptris.com/products/intelliprint/public/download/IVAxSetup.exe 

• To create reports or formats install one licensed copy of IntelliVIEW for Notes 

designer on the Notes client.  

 

 

 

 

 

For the Administrators 
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Installing IntelliVIEW for Domino 

Perform the following steps to install IntelliVIEW for Domino in the Domino Server. It can 

be accessed from client machines with the IntelliVIEW ActiveX plug-in installed on them. 

Installation can be anew or upgrading from an older version. 

 

New Installation 
 

1. Install IntelliVIEW for Domino on the Server where the Notes web enabled 

applications are installed. Open the IVDomSetup.exe file. The IntelliVIEW for Lotus 

Domino Setup screen is displayed. 

 

 

 

 

 

 

2. The Setup then displays the License Agreement for the purchase and usage of 

IntelliVIEW for lotus Notes. Read the agreement completely and accept the license 

agreement, if you wish to continue with the installation. Click on Next to continue. 

3. Setup next prompts for the path for installation. By default, IntelliVIEW is installed 

in the notes directory. You can choose to accept the default path or choose a location 

of your choice to store the installation files and sample databases. Click ‘Next’ to 

proceed with the installation.  

4. Now you can select the modules to be installed. Select the desired modules and click 

Next to install the software. 

5. Once the installation is over, the Installation Complete screen will be displayed. 

Select the option Yes, I want to launch readme file to view the contents of the readme 

file. Click on Finish to complete the installation. IntelliVIEW for Domino is installed 

in your system. It can be accessed from client machines with the IntelliVIEW ActiveX 

plug-in installed in them.  

  

  

 

Note: If you already have an older version of IntelliVIEW installed in the directory specified, the 
installer will give you two options - Modify and Remove. Select the option Modify to repair the 
previous installation or install the software in a new location. Select the option Remove to uninstall 
IntelliVIEW from your system. 
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Configuring the Domino Server 

After installing IntelliVIEW for Domino on the Domino Server, the administrator needs to 

configure the Server for IntelliVIEW. 

 

The following configuration settings should be made in the Server Document of the Domino 

Server:  

  

Open the Server Document of the Domino Server in the Notes client. 

  

Go to the tab Security. 

  

In the Server Access section specify “No” against the option only allow server access to the 

users listed in this directory.  

 

In the Agent Restrictions section, add the User ID (or the group in which it is a member) who 

has signed the database to both Run restricted Lotus Script/Java agents as well as Run 

unrestricted Lotus Script/Java agents. If you don’t want to change these values in the server 

document, then you should sign the Notes Database* with the User ID who has access to run 

Lotus script agents on the Domino Server.  

  

*The Notes database mentioned is the one on which you want to use IntelliVIEW for Domino. 

Go to the tab Ports and then click the sub tab Notes Network Ports tab. 

Specify the correct Net Address (name of the machine which runs Domino server) for the 

TCPIP Port.  

  

 

 

 

  

 

Note: The Domino Server should be given appropriate access in the database access control lists 

(ACL) and the roles should also be enabled, so that the server has access to all the documents in the 

database. 
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Creating IntelliVIEW Report Formats in the Domino 

Server 

  

IntelliVIEW report formats are created using Lotus Notes Client. 

  

To create IntelliVIEW report formats on the Domino Server, the administrator has to sign on 

the Notes client at the Domino Server, and create formats using the IntelliVIEW for Domino 

component installed in it. Then these reports are published to web through an action button 

or a link in the web page. 

  

Creating a Format 
 
This is done in the same way as for the Notes version of the product. Please refer session 1. 

 

Creating Action Buttons to invoke IntelliVIEW from the Browser 
  

Having configured the Domino Server, we now need to create Action buttons on the Domino 

application for activities such as starting IntelliVIEW, exporting reports from the Browser, 

printing etc.  

  

The following activities are involved in creating IntelliVIEW action buttons for any database. 

 

• Copy the script libraries IPDeclarations and IVForDominoV2 available in the sample 

database (generally in the directory; Intelliview\iview.nsf) to the user's database.  

 

• Copy the agent named LaunchIViewV2 from the sample database to the user's 

database   

 

• Create an action button named IntelliVIEW in the View of the user's database, from 

which IntelliVIEW needs to be invoked. 

 

• In the Click event, place the code given below.  
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DBPath:= @ReplaceSubstring(@Subset(@DbName;-1);"\\":" ";"/":"+"); 

URL := "/" + DBPath + "/LaunchIViewV2?OpenAgent&View=SalesByPerson&FileType=0"; 

@URLOpen(URL) 

  

Specify the view name in &View=, to open the particular View. 

Specify the format name in &format=, to open a particular format. 

  

In &FileType= specify one of the following: 

  

0 – to launch the format/ view as IntelliVIEW dynamic spreadsheet in the Browser 

1 – to export the view/format to PDF 

2 – to export the view/format to TXT 

3 – to export the view/format to XLS   

  

Script Layer Function Declarations for Notes 

  

Use this below declarations before using IntelliVIEW Script Layer functions for Notes. This 

can be written in the Declaration area of a Script library, agent etc. 

 

Declare Function IVSExport Lib "NIVIEW.DLL" (Byval strServerName As String, Byval 

strDbPath As String, Byval strViewName As String, Byval strFormatName As String, Byval 

iExportType As Integer, Byval strFilePath As String) As Long 

  

Declare Function IVSView Lib "NIVIEW.DLL" (Byval strServerName As String, Byval 

strDbPath As String, Byval strViewName As String, Byval strFormatName As String) As 

Long 

 

Declare Function IVSBrowse Lib "NIVIEW.DLL" (Byval strServerName As String, Byval 

strDbPath As String, Byval ViewName As String) As Long 

 

Using IVSGetData to open the IntelliVIEW Grid on the Browser 

 
The function IVSGetData is used to create the action button for opening the IntelliVIEW 

Grid on the Browser 

The syntax, arguments and API declaration for this function are given below. 
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Syntax 
  

Function IVSGetData Lib "IVSVR.DLL" (Byval svrname As String, Byval dbpath As String, 

Byval filename As String, Byval httppathOfFile As String, Byval viewname As String, Byval 

formatname As String) As Long 

   

Arguments 

  

  

Description 

svrname 

  

Name of the server 

dbpath Path of the database 

  

filename Path of the directory in which the IntelliVIEW files 

will be created i.e., domino data 

folder\domino\html\iview\filename (any unique file 

name)For example, 

D:\Lotus\Domino\data\domino\html\iview\IV_ 

RNIA-5F5DMY (any unique file name) 

  

httppathOffile The entire URL with which the generated IVIEW 

files can be viewed through the Browser i.e., 

http://servername/iview/filename (any unique file 

name)For ex: http://203.197.140.172(Server IP 

address)/iview/ IV_ RNIA-5F5DMY (any unique file 

name)   

  

viewname Name of the View, which needs to be previewed in 

the Browser 

  

Formatname Name of the format that needs to be previewed in the 

Browser. 

  

 

 
Note: Either viewname or formatname can be given as argument. If both the arguments are 

given, viewname takes precedence. 
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Return values 

Long. 

Returns zero if no error occurred while previewing the document. Otherwise returns 

IntelliVIEW error code. 

  

 

API declaration 

  

Declare Function IVSGetData Lib "IVSVR.DLL" (Byval svrname As String, Byval dbpath As 

String, Byval filename As String, Byval httppathOfFile As String, Byval viewname As 

String, Byval formatname As String) As Long 

  

  

Sample Usage 

  

Dim filename As String 

Dim httpPathOfFile As String 

Dim ret as long 

  

filename = "D:\Lotus\Domino\Data\domino\html\IVIEW\" 

filename = filename + "IV_ RNIA-5F5DMY" 

httpPathOfFile = "http:// 203.197.140.172/iview/ IV_ RNIA-5F5DMY" 

ret = IVSGetData("CSSDEV2/CYBERNET", "Intelliview\IVIEW.NSF", filename, 

httpPathOfFile, "SalesByMonth", "") 
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Using IVSExport to export reports from the Browser 

  

The function IVSExport is  used to create the action button for exporting reports from the 

Browser. 

The syntax, arguments and API declaration for this function are given below. 

  

Syntax 

Function IVSExport Lib "NIVIEW.DLL" (Byval strServerName As String, Byval strDbPath 

As String, Byval strViewName As String, Byval strFormatName As String, Byval 

iExportType As Integer, Byval strFilePath As String) As Long 
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Arguments 

  

  

Description 

strServerName  

  

Name of the server 

  

strDbPath 

  

Path of the database 

  

strViewName 

  

View name to be previewed with IntelliVIEW  

  

strFormatName 

  

Name of the format to be previewed with IntelliVIEW 

iExportType 

  

  

Specify the format in which the report has to be 

exported. 

  

1 – PDF 

2 – TXT 

3 - XLS 

 

  

strFilePath 

 

 

 

 

 

 

 

 

 

 

  

Path to export the file in the specified format i.e., 

domino data folder\domino\html\iview\filename (any 

unique file name) 

  

For example:  

D:\Lotus\Domino\data\domino\html\iview\IV_ 
RNIA-5F5DMY  
  

Note: Either strViewName or strFormatName can be given as argument. If both the arguments 

are given, strViewName takes precedence. 
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Return values 

  

Long. 

Returns zero if no error occurred while previewing the document. Otherwise returns 

IntelliVIEW error code. 

  

  

API declaration 

  

Declare Function IVSExport Lib "NIVIEW.DLL" (Byval strServerName As String, Byval 

strDbPath As String, Byval strViewName As String, Byval strFormatName As String, Byval 

iExportType As Integer, Byval strFilePath As String) As Long  
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______________________________________________________________________________________ 

Starting IntelliVIEW from the Browser 

Once the necessary configuration is done and Action Buttons are created, the user can 

launch the IntelliVIEW client by clicking the IntelliVIEW Action button. Open the Domino 

application in the Browser and start using IntelliVIEW. 

  

Type the unique IP address of the Domino database on your Browser’s address box. For ex:  
http://209.10.58.133/demo/iview.nsf. (This will open a sample Domino application that has 

been configured for IntelliVIEW) The Domino application is displayed with action buttons as 

shown below. 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 
 
 
 
 

For Users 
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 Select a View and click the “IntelliVIEW” button to invoke IntelliVIEW. 

  

The IntelliVIEW Grid is displayed with the data in the selected View as shown below. Views 

can be switched using the navigation pane on the left. (if you are starting IntelliVIEW for the 

first time from your Browser, the ActiveX plug-in will download automatically and then you 

will be able to see the IntelliVIEW Grid in your Browser) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 
 

Saving a format on the Browser 

IntelliVIEW for Domino allows you to save reports and formats after performing ad-hoc 

analysis over the Browser. 

  

Click the Save icon  to save the format in any available network place. 

The format is saved as an IntelliVIEW data file. (With an extension .IVDAT) 

  

Clicking the Open icon can open the saved formats. 
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IntelliVIEW ActiveX Plug-in 

After installing IntelliVIEW for Domino in a Domino server, it is mandatory to get the 

IntelliVIEW ActiveX plug-in installed in all its client machines to enable them to display the 

IntelliVIEW Grid on their Browsers. 

  

Open the IVAxSetup.exe file to install the plug-in in you r system. 

  

Data Analysis using IntelliVIEW for Domino 

The prime objectives of IntelliVIEW for Domino is to enable users analyze data over the web 

and create ad-hoc reports. 

All the data analysis operations are possible using IntelliVIEW for Domino.  
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Formatting Reports on the Browser 

IntelliVIEW for Domino offers all the formatting options available in IntelliVIEW for Notes. 

With the following features, you will be able to create elegant reports quickly and easily, 

even over the Web. 

  

• Grid Settings 

• Formatting Columns, Rows and Cells 

• Formatting Headers and Footers 

  

Exporting Reports from the Browser 

To export reports from the Browser, perform the following steps.  

Click the  icon. The Save as dialog is displayed with provision to Save as type PDF, Excel 

or Text.  
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Select the required file type and click Save to save the report in the specified location.  

Previewing and Printing over the Browser 

 The Preview of reports from the Browser, is launched in Acrobat PDF, from which they can 

be printed. Perform the following steps to print the report displayed on the IntelliVIEW Grid. 

 

Print Setup 
  

There is a facility to force new pages for each group (if the report contains groups)and select 

a paper size, before previewing.  

  

• Click the icon. The Print Setup dialog is displayed. 

• Select a group name by checking the check box, if it should start from a fresh page.  

• Click the tab Size. 

• Select the required paper size from the drop-down list. 

• Select the type of page orientation, suitable to your report. 
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Previewing and Printing 
 
Click the  icon to preview the report. To print the report click the  icon  
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______________________________________________________________________________________ 

 

What you can’t do through the Browser? 

There are a few limitations in IntelliVIEW for Domino when compared to IntelliVIEW for 
Notes. This section lists out the operations not possible with IntelliVIEW for Domino but 

which are available in IntelliVIEW for Notes. 

  

• Opening a View from a different database - IntelliVIEW for Domino can be used only 

when each database is customized with the respective action buttons. Hence, opening 

a View from a different database is not possible. 

• Adding columns to the Grid - After opening a View in the browser trough 

IntelliVIEW Grid it is possible to remove columns.(Right click on a column and select 

Delete Column.) However, it is not possible to add additional columns to the Grid by 

selecting fields from the database.  

• Advanced Filtering – Basic Filtering can be done in IntelliVIEW for Domino. 

However, Advanced Filtering option is not available.  

• Active Chart – Charts can be created using chart wizard. However, Active chart is 

not available. 

• E-Mailing Reports - The feature of E-Mailing reports directly from the IntelliVIEW 

application using the default client id, is not available in IntelliVIEW for Domino.  

 

 
 
 
 
 

Limitations 
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